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OPHTHALMIC PHOTOGRAPHERS' SOCIETY

EYE IMAGING EXPERTS

INTRODUCTION

Welcome. Thank you for your interest in the Optical Coherence Tomographer-Certified Program. This Program Guide
details the process and procedures involved in becoming OCT-C Certified. It contains the program application, details the eligibility
and portfolio requirements and includes the examination content outline. The OCT-C Program is administered by the Ophthalmic
Photographers’ Society Board of Certification (OPS BOC) http://www.opsweb.org/Certif/Certif.html.

The Ophthalmic Photographers’ Society is a non-profit organization dedicated to a highly specialized form of medical photography.
The main objectives of the Society are to provide primary and continuing education in the field of ophthalmic imaging, to set and
maintain standards for the profession through certification programs, and to promote scientific advancement in the technology.

The Society provides for the sharing of information, sponsors meetings to promote the exchange of information and serves as a
professional organization for its members, sponsoring educational meetings and promoting the field nationwide.

The OPS holds its Annual Educational Meeting in conjunction with the annual meeting of the American Academy of Ophthalmology.
The OPS meeting program includes presentations of papers on advances in scientific photography and instrumentation, as well as an
extensive educational program.

OPS’ membership includes ophthalmologists, optometrists, veterinarians, pathologists, medical and ophthalmic photographers,
nurses, ophthalmic assistants, technicians, technologists, researchers, and engineers. Active members promote the objectives of the
Society. Sustaining members are organizations and individuals actively involved with ophthalmology or ophthalmic photography
for commercial or charitable purposes. Anyone involved in ophthalmic photography is encouraged to apply to the OPS Membership
Office (ops@opsweb.org).

The Society created the Board of Certification (BOC) in 1979. The OPS BOC serves as the formal body responsible for the
certification of retinal angiographers and ophthalmic photographers. Optical Coherence Tomographer (OCT-C) Certification requires
submission of work examples that meet established standards and successful completion of a written examination. Membership in the
OPS, while encouraged, is not a requirement for Certification.
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CERTIFICATION POLICIES

The Ophthalmic Photographers’ Society Board of Certification (OPS BOC) is responsible for certification of retinal angiographers and
ophthalmic photographers. Certification designates an individual who has met the OPS BOC'’s standards of competence. The Board of
Certification administers all examinations.

OCT-C

The Optical Coherence Tomographer-Certified designates an individual who has met the OPS BOC standards of competence
in optical coherence tomography. The OPS BOC standards are meant to assure delivery of competent, professional optical coherence
tomography services.

OCT-Cs demonstrate competence by understanding and being able to:

e Apply the Principles of the Anatomy of the Eye

e Apply the Concepts of Pathology of the Eye to OCT findings
e Recognize and identify clinical OCT findings

e Apply the properties of OCT equipment and protocols

e Interpret OCT images and analyses

OCT-C examinations are offered three times a year in different regional locations and testing centers. The examination schedule is
published on the OPS Website (http://www.opsweb.org), and in the OPS Newsletter. The examination dates and locations are
announced at the OPS Annual Educational meeting each fall.

The Ophthalmic Photographers’ Society Board of Certification is the only agency authorized to designate an individual as an

Optical Coherence Tomographer-Certified. The OPS BOC developed its program to facilitate voluntary certification of ophthalmic
photographers and technicians. Its sole purpose is recognition of attainment of a standard level of knowledge and skill in optical
coherence tomography. Certification does not guarantee recognition by any other individual, group, agency or institution; the liability
of the OPS BOC or its representatives is limited strictly to this recognition by the OPS BOC.

STATEMENT OF NONDISCRIMINATION

The Ophthalmic Photographers’ Society Board of Certification shall admit applicants of any age, sex or sexual orientation, race,
religion, color, national origin, handicap or marital status to all rights, privileges, programs, and examinations generally made
available through its association. It shall not discriminate on the basis of age, sex or sexual orientation, race, religion, color, national
origin, handicap or marital status in the administration of its certification policies.
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APPLICATION PROCESS

OCT-C applicants may download a Program Application from the OPS Web Site (http://www.opsweb.org) or request an
application from the OPS Membership Office (1-800-403-1677 or OPS@opsweb.org). The completed application and portfolio should
be submitted to the Portfolio Committee Chair with a non-refundable application fee of $50.00 (Checks made payable to OPS BOC).
To ensure evaluators have adequate time to review your portfolio, the application and portfolio should be submitted a minimum of
eight weeks in advance of a desired examination date. Portfolio requirements are detailed on page 9.

Submission of the Program Application establishes a relationship between the Ophthalmic Photographers’ Society Board of
Certification and the individual applicant. All correspondence, scores and certificates are mailed directly to the applicant’s home
address. Each applicant is responsible for notifying the Board of Certification directly of any change of name or
address. This will enable all confidential correspondence concerning certification and recertification to reach the applicant.

By applying for the OCT-C examination the applicant agrees to the terms set forth in this program guide regarding certification
requirements and examination. Applicants attest that all information they submit is true and complete to the best of their knowledge.
Any misrepresentation or misconduct in the application or examination process may result in disqualification or revocation of
certification. (See “Disciplinary Policy” on page 20)

Once the portfolio committee approves the portfolio, the OCT-C Section Chair will mail the applicant an Examination Application
and a schedule of the upcoming examinations. The application must be completed and returned along with the examination fee
(Checks made payable to OPS BOC) and a letter of employment verification. Examination applications must be received at least six
weeks before any test date. Eligibility requirements for the OCT-C Program are explained in greater detail on page 8. The Board

of Certification reserves the right to limit the number of applicants accepted for a scheduled examination, or to cancel a scheduled
examination.

PROGRAM FEES

Program Application Fee: $50.00 (non-refundable)
Examination Fees: Written Written Retesting Fee
Non - Member $215.00 $200
OPS Member $175.00 $150
Materials Fee: Written Written Retesting Fee
$25.00 $25.00
*Test Center Fee: $70.00

*Only applicable when candidates take the written examination at Schroeder Measurement Technologies, Inc. (SMT)
testing centers.

Materials Fee: The materials fee covers test boolket production, scoring and reporting. This fee is in addition to the
Examination Fees. The Materials Fee is a pass-through fee from the testing company contracted to perform these
services for the OPS BOC.

Test Center Fee: The test center fee is a seat fee for examination when candidaates sign up to take the written

examination at testing centers. This fee is in addition to the examination and materials fee above. The test center fee is a
pass-through fee from the testing company contracted to perform these services for the OPS BOC.

Note: All fees must be remitted in US dollars. Payment by credit card can be made on the OPS Website “Store”
(opsweb.org) or with the OPS Membership Office (1-800-403-1677).

***All bank fees related to insufficient funds will be invoiced to the applicant.***
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REFUNDS

Examination fees will be fully refunded if an applicant submits written notification at least two weeks before a scheduled
examination. Refunds for cancellations received fewer than two weeks before the scheduled examination are subject to a $50.00
cancellation fee. Refunds are made payable and mailed to the party that originated the check covering the examination fee.

Once applicants have opened the test booklet in the written examination, they are considered to be present and are no longer eligible
for a refund.

No refunds or credits will be issued to those who fail examinations or to those who do not appear for the examinations.

SPECIAL TESTING ARRANGEMENTS

Applicants who have been diagnosed with a physical, mental or reading impairment, as defined by the Americans with Disabilities
Act, may receive assistance when taking the test. If you have a disability that would prevent you from taking the examination under
standard test conditions, contact the OCT-C Section Chair to apply for special accommodations at least six weeks prior to a scheduled
test date.

Applicants whose religious practices prevent them from taking the examination on Saturdays or Sundays should contact the OCT-C
Section Chair to apply for special accommodations at least six weeks prior to a scheduled test date.

The OCT-C Section chair will make a reasonable effort to accommodate requests for special testing arrangements. These
arrangements, if approved by the Board of Certification as reasonable for conducting of the examinations, will be provided at no
additional charge.

REPORT OF EXAMINATION RESULTS

Applicants will be notified by mail of their results within six weeks of the test date. Applicants who pass the examination will
receive a report noting only that they have passed the examination. The OCT-C examination is designed to be a minimum competency
examination, and is not intended to distinguish scores achieved above the passing point. Therefore, no numeric scores will be reported
for applicants who pass the examination. The OPS BOC established this policy as a safeguard against misuse of examination scores.

Applicants who do not pass the examination will receive notice of their score with a diagnostic report showing areas of strength and
weakness.

The OPS BOC will not release any results early; all examination results are mailed at the same time. No examination results will be
reported by telephone. Results of the examination are confidential and are released only to the applicant. The OPS BOC reserves the
right to release a certificant’s name and status to the general public.

RECEIPT OF CERTIFICATION

Once the Board of Certification notifies applicants that they have completed all requirements for certification, they may use the title
Optical Coherence Tomographer (final designation to be announced) as long as the certificant maintains his or her certification (see
recertification guidelines on page 18). This designation may be used as part of a signature, and on letterheads and business cards etc.
The OPS BOC mails Certificates to successful applicants with their notification.

RE-EXAMINATION

Re-examination of the OCT-C written examination requires filing an examination application and fee. The fee for re-examination can
be found in the FEES section. Applicants should review their detailed examination results to determine those subject areas in which
further study may be needed.

APPEALS AND GRIEVANCES

Should certification be denied, applicants have 30 days to appeal the decision in writing to the OCT-C Section Chair. Should the
section chair deny this appeal, the applicant has another 30 days to appeal to the Board of Certification. Any charge or complaint will
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be investigated, reviewed and reported to all parties concerned. The Chairman of the OPS BOC may appoint a special committee to
conduct an impartial review. The members of the committee shall be outside the sphere of OPS BOC influence. The committee will
make recommendations to the OPS BOC. The OPS BOC, which will deliberate and vote as a whole, shall render the final decision
regarding the recommendation of the committee. The OPS BOC’s decision is final and binding.

REVOCATION

Fraud or misrepresentation on the application, portfolio, or in the examination can result in denial or revocation of Certification. The
OPS BOC reserves the right to void examination results, bar participation in the certification program and revoke certification or other
sanctions in accordance with the Disciplinary Policy (Page 20). The OPS BOC will consider such actions if members have reason to
question the validity of an applicant’s examination results, suspects misconduct at a test center or suspects an applicant has reported
fraudulent information. Denial or revocation of certification may be appealed in writing to the Chairman of the OPS BOC.

RECERTIFICATION

OCT-C recertification is required at three-year intervals following initial certification. The requirements for recertification are listed on
page 18.

RECORDS

All applications, correspondence, supporting documentation and materials generated in the testing process will be held for one year
following attainment of the OCT-C credential. Computer records of applicant demographics and test scores are kept indefinitely.

STATEMENT OF PROPRIETARY INTEREST

The Board of Certification has no commercial or proprietary interest in any products used or mentioned in the certification program.
The use of brand names in this program guide or on any examination, is only for illustration and does not imply OPS BOC
endorsement.
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REQUIREMENTS FOR CERTIFICATION

EXAMINATION ELIGIBILITY REQUIREMENTS

Eligibility for the written examination is contingent upon fulfilling these requirements:

1. Submission and acceptance of a satisfactory portfolio (See Portfolio Requirements).

2. Aletter from the employing physician(s) or institution(s) verifying the applicant’s employment history with Optical Coherence
Tomography as part of responsibilities for a minimum of one year.
This one-year work experience requirement is meant to allow time for an applicant to acquire, through hands-on experience, the
knowledge and skills necessary to perform optical coherence tomography. It should include enough patient interaction to allow
an applicant to develop the clinical judgment and patient management skills necessary for competent performance as an optical
coherence tomographer. A competent optical coherence tomographer must be able to elicit cooperation from a non-cooperative or

challenging patient for acceptable performance of OCT imaging.

Internships or practicum are considered part of a formal education program. These clinical experiences do not qualify as work
experience.

VERIFICATION OF ELIGIBILITY INFORMATION

The Board of Certification reserves the right to verify the experience attested to by the applicant by calling the employer(s) listed on
the application form or requesting written documentation of the submitted information either prior to or after the examination.

Applicants will be declared ineligible for examinations if any of their eligibility requirements are found to be unsatisfactory.

SUCCESSFUL COMPLETION

The following requirements are necessary to achieve the OCT-C designation by the Ophthalmic Photographers’ Society Board of
Certification.

Applicants must achieve:
e satisfactory completion of all eligibility requirements

e apassing score on the written examination.
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PORTFOLIO REQUIREMENTS

SECTION OUTLINE

Portfolio Requirements

Portfolio Rating Standards

Portfolio Assembly

Portfolio Submission Guidelines

Portfolio Submission Form
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PORTFOLIO REQUIREMENTS

The portfolio must be produced entirely by the applicant. These requirements are for the Stratus instrument. Portofolio
requirements for all other OCT-C instruments are available for download on the OPS website or by emailing oct@opsweb.org

The portfolio submission form (page ) must be completed and submitted with the portfolio. By signing the portfolio
submission form, the applicant attests to the authenticity of the work submitted. Submission of work completed by anyone
other than the applicant constitutes fraud. Fraud or misrepresentation of the portfolio may result in disqualification of the
applicant.

Label all files with your last name as a prefix to the Item #. For example, the submission set for # 7 should be labeled:
“your last name””7a (SMITH7a). Complete Naming and Labeling conventions can be found on page 12.

Normal eyes can be used when pathology is not specified in the item description. If applicable, the same eye may
be imaged for multiple items.

1. Submit a serial set of two Fast Macular Thickness Maps of one eye with normal foveal thickness (less than 200
microns as measured using the central subfield thickness measurement.) The scans must be performed on the same day
of the same eye with a minimum of five minutes and a maximum of eight hours between scans — make a note of time. The
center point thickness measurement of each map must be within 10 percent of each other.

a. Submit the Retinal Map Analyses of both scans
i. Label first map: 1A
ii. Label second map: 1B + the length of time between scans (for example: 1BS for +5 minutes or

1B1HR for + 1 hour)

2. Submit a serial set of two Fast Macular Thickness Maps of one eye with central foveal thickness (greater than 350
microns as measured using the central subfield thickness measurement.) The scans must be performed on the same
day of the same eye with a minimum of five minutes and a maximum of eight hours between scans — make a note of
time. The center point thickness measurement of each scan must be within 10 percent of each other.

a. Submit a retinal thickness analysis of each of the six scans of the FIRST Fast Macular Scan
i Label set: 2A1, 2A2, 2A3, 2A4, 2AS, 2A6
b. Submit the Retinal Map Analyses
i. Label first map: 2B
ii. Label second map: 2C + the length of time between scans (for example: 2CS for +5 minutes or

2C1HR for + 1 hour)

3. Submit the specified scan and analyses sets for_one eye for four of the five conditions below:
a. Cystoid Macular Edema
. SCAN: Macular Thickness Map or Radial Lines ANALYSIS: Retinal Map
1. Label 3A1
il. From the same capture, submit the individual line scans for 0 degree and 90 degree
1. Label 3A2 and 3A3
b. Macular Hole/ Macular Traction
1. SCAN: Line Scan ANALYSIS: Normalize
1. Label 3B1
ii. SCAN: Cross Hairs ANALYSIS: Align
1. Label 3B2a and 3B2b
c. Glaucoma
1. SCAN: Fast RNFL Thickness(3.4) ANALYSIS: RNFL Thickness Avg
1. Label 3C1
ii. SCAN: Fast Optic Disc ANALYSIS: Optic Nerve Head
1. Label 3C2 - Provide first scan (90 degree)
d. Retinal Pigment Epithelial Detachment
. SCAN: Line ANALYSIS: Proportional
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1. Label 3D1

ii. SCAN: Fast Macular Thickness Map ANALYSIS: Retinal Map
1. Label 3D2
e. Age Related Macular Degeneration
I SCAN: Fast Macular Thickness Map ANALYSIS: Retinal Map
1. Label 3E1
ii. SCAN: Macular Thickness Map or Radial Lines ANALYSIS: Retinal Map
1. Label 3E2

The central thickness measurement of 3E1 map must be within 10 percent of 3E2map.

4. Acquire a Fast Macula Thickness and a Fast RNFL scan through an un-dilated or minimally dilated
pupil. Pupil size should be less than 4mm. Both scans must be acquired on the same eye. Signal strength must be
five or better on all scans.

a. Provide ONLY a Retinal Map and RNFL Thickness Average.
. Label Retinal Map: 4A
ii. Label RNFL Thickness Average: 4B
5. Acquire a high resolution (512 A scans) Line scan through a media opacity (i.e. cataract, vitreous hemorrhage,

or debris) of a patient with macular or foveal pathology. Scan should illustrate compromised scan quality (signal
blocking or “shadowing”) from the opacity.

a. Analysis: Align
I Label: SA
6. On the same eye used for Item #5, acquire a high resolution (512 A-scans) Line scan around media opacity (i.e.

cataract, vitreous hemorrhage or debris). Scan angle or positioning within pupil should be adjusted to minimize
(signal blocking or “shadowing”) from the opacity and illustrate improved visibility of pathology.

a. Analysis: Align
I Label: 6A
7. Acquire one high resolution (512 a-scans) line scan at 6mm vertical (at 90 degrees).
a. Analysis: Align or Proportional
I Label: 7A
8. Acquire one high resolution (512 a-scans) line scan at 10mm horizontal (at O degrees).
a. Analysis: Proportional
I Label: 8A
9. Acquire a 7mm scan centered on the fovea in the right eye, with a 5° incline from temporal to nasal.
a. Analysis: Align or Proportional
I Label: 9A
10. Using any line scan, provide a Retinal Thickness (single eye) Analysis using the calipers to measure retinal pa-
thology. Caliper placement and measurement must be displayed on print/file.
a. Analysis: Retinal Thickness (single eye)
I Label 10A

¢ All scan sets must be properly anonymized (de-identified), labeled and submitted to the OCT-C Portfolio Committee.
* Scan sets may be submitted either in digital or print form.

* Acceptable methods for de-identification can be found in the Appendices.

¢ Guidelines for SD-OCT instruments are available for download on the OPS website or by email: oct@opsweb.org
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PORTFOLIO RATING STANDARDS

The Portfolio Committee uses standards established and approved by the Board to perform ratings of OCT-C portfolios. Two
members of the Portfolio Committee independently rate each portfolio and, when required, the Committee Chair arbitrates scores.

OCT-C portfolios are rated by applying the following standards:

Intent: Is the required image present?

Protocol: Does the image show the specified scan and analysis protocol?

Scan Quality: Are the scan paramaters within an acceptable range?

Artifacts: Is the image free of undesirable artifacts?

Labeling: Is the image de-identified of private health information and labeled properly?

All criteria for each required image must be met for the portfolio to be found satisfactory. Item specific criteria are identified in the
Portfolio Guidelines (page 10).

PORTFOLIO ASSEMBLY

The required image files must not contain any patient information and must be labeled as descibed below.
ACCEPTABLE METHODS OF IMAGE SUBMISSION

Images may be submitted digitally. Digital images may be submitted in pdf or jpeg format.

ACCEPTABLE METHODS OF DE-IDENTIFICATION

All images must be de-identified (anonymized); no patient information can be visible on the submitted images.
Acceptable methods to remove/replace the patient information with the provided naming convention can be
found in the Appendices of this guide.

NAMING CONVENTION FOR OCT SCAN PORTFOLIO SUBMISSIONS
Last Name: OCT Certification

First Name: Candidate Name (Your Name)

Birth date: 1-1-1900

Patient ID: Item # (Example : ltem 1A or 3C)

LABELING CONVENTION FOR PORTFOLIO SUBMISSIONS

Name each individual file with the appropriate image number as defined in the Portfolio Requirements (page 10).

The portfolio will be deemed unsatisfactory if it contains extra examples of the requested images or contains any
patient information.
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PORTFOLIO SUBMISSION

The portfolio must be uploaded to the OPS BOC or submitted on a single, non-rewritable CD/DVD. Take the same care packaging
your portfolio as you did producing it. Package the CD/DVD in a jewel case and mail in a bubble envelope. Portfolios will not be
returned to candidates, please maintain a copy for yourself.

Complete the Portfolio Submission Form (page 43) and place it in the envelope with the CD/DVD submission.

Do not include your employment verification letter with this submission. These documents are submitted with the Examination
Application.

Upload the portfolio at: http://www.opsweb.org/Certif/portfolio_upload.html or send the portfolio to the address on the portfolio
submission form. The OCT-C Portfolio Committee will review the portfolio within 30 days. Portfolios meeting the requirements will
receive an email noting acceptance. Portfolios not meeting the requirements will receive a critique of the unacceptable segments. The
applicant can correct any deficiencies and resubmit the required component(s); if the portfolio committee returns the entire portfolio,
correct the required components and resubmit the entire portfolio.

The Ophthalmic Photographers’ Society Board of Certification assumes no liability for any materials lost or damaged in shipping/
transfer. The Board of Certification recommends that applicants maintain a copy of the portfolio for their personal records.

The Portfolio Committee will notify the OCT-C Section Chair of the applicant’s examination eligibility. The Section Chair will send
the applicant an Examination Application and information regarding upcoming examination dates.
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OCT-C EXAMINATION

EXAMINATION PHILOSOPHY

The designation of OCT-C is meant to assure the “consumer” that the certificant has demonstrated an established level of competency
in performing OCT imaging. No barriers exist to discriminate against applicants for testing. Certification requires a thorough
knowledge of the subject matter. The examination is designed to pass applicants who display a level of knowledge and ability to
perform competently as an optical coherence tomographer.

EXAMINATION PROCEDURES

The OCT-C written examination is conducted in one day. Time is not intended to be a factor in the completion of the examination.
Sufficient time is allotted for each examination section to be completed.

PREPARING FOR THE EXAMINATION

The OCT-C examination tests the applicant’s knowledge of optical coherence tomography imaging. The Examination Content Outline
and Weightings (page 15) identify the areas in which to concentrate for the examination.

A list of study resources begins on page 21. The list is not meant to represent all material covered by the examination. OPS
sponsored courses, workshops, accompanying handouts and the OPS Web Site at http:/www.opsweb.org provide additional
valuable resources.

RULES FOR EXAMINATIONS

*  The examinations will be administered only on the date and time posted except for applicants who have requested and received
special testing arrangements. Please be prompt. Late arrivals will not be admitted to the exam.

e During the registration period, applicants reporting for examination must sign the test site roster and provide a photographic
identification, such as a driver's license or passport.

e No books, papers, reading materials or sratch paper may be on the exam tables. Purses, bags and brief cases must be under
your seat during the examinations.

e No test materials, documents or scratch/work sheets of any sort are to be taken from the examination rooms.
e During any segment of these examinations, applicants can not give or receive help from other examinees. Examiners are
required to report any instance where there is evidence of cheating. Any such evidence will result in the cancellation of test

scores or disqualification from the certification program.

e All instructions given by the examiners must be followed and all directions on the exam booklet should be read in order to
assure proper processing of examination results.

e If you have difficulty with the directions during the written examination please raise your hand until an examiner assists you.

e It is the responsibility of all applicants to make sure that all the information requested on the exam book cover is current and
correct.

e If an applicant leaves the room during the exam, he or she must have the examiner's permission. Belongings must remain in the
exam room. No additional time will be given.

e Visitors are not permitted in examination areas.
e The chief examiner may dismiss an applicant from the test as he or she deems appropriate, for example: if admission to the

center is unauthorized; if an applicant creates a disturbance; if an applicant gives or receives help; if an applicant attempts to
remove test materials or notes from any examination room; or if an individual impersonates an applicant.
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WRITTEN EXAMINATION CONTENT OUTLINE and PERCENTAGES

L Applies the Principles of the Anatomy of the Eye 20%
A. Demonstrates an understanding of anterior and posterior segment structures
B. Demonstrates an understanding of the layers of the retina
C. Demonstrates an understanding of optic nerve anatomy
D. Demonstrates an understanding of anatomical landmarks and terminology
1L Applies the Concepts of Pathology of the Eye to OCT findings 20%
A. Recognize and identify the ocular manifestations of:
1. retinal diseases
2. optic nerve disorders
3. systemic diseases
B. Recognize and identify the clinical OCT findings of:
1. diabetic retinopathy/macular edema
2. macular degeneration/choroidal neovascular membrane
3. central serous retinopathy/subretinal fluid
4. cystoid macular edema/diffuse macular edema
5. retinal holes: pseudo/lamellar/full thickness
6. glaucoma
7. papilledema/optic pit
8. epiretinal membrane
9. vitreomacular traction
10. posterior vitreous detachment/weiss ring
11. pigment epithelial detachment
12. retinal detachment/retinoschisis
13. drusen/ hard and soft exudates
14. drusen, ONH
15. pathologic myopia
16. retinal nerve fiber layer defects
17. venous/arterial occlusions
18. tumors/nevi
19. asteroid hyalosis/vitreous hemmorhage
111 Patient Management 5%
A. Informs patient of procedures to be performed.
B. Answers patient questions concerning the procedure
C. Establishes fixation
D. Elicits cooperation from uncooperative or physically disabled patients
E. Establishes/reviews patient records including
1. medical/surgical history
2. ocular history
3. photographic history
Iv. Optical Coherence Tomography (OCT) 30%
A. Understands the use of OCT equipment and properties:
1. Understands the function and components of the OCT machine including:
a. wavelength of light
b. limitations of machine
c. working distance
d. resolution
2. Performs routine maintenance and equipment troubleshooting including:
a. cleaning equipment
b. software maintenance
3. Understands and applies scanning protocols
a. Retina
1. Macular thickness map/Radial Lines
2. Fast macular thickness map
3. Optic Disc/Fast Optic Disc
4. RNFL thickness 3.4/Fast RNFL Thickness 3.4
5. RNFL map/Fast RNFL map
6. Nerve head circle
7. Line
OCT-C Program Guide V1b 15
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8. Circle
9. Raster Line
10. Cross hair
I1. Radial lines
12. X-line
13. Custom Scan
14. Repeat
b. Glaucoma
1. Macular thickness map/Radial Lines
2. Fast macular thickness map
3. Optic Disc/Fast Optic Disc
4. RNFL thickness 3.4/Fast RNFL Thickness 3.4
5. RNFL map/Fast RNFL map
6. Nerve head circle
7. Line
8. Cross hair
9. Custom Scan
10. Repeat
4. Understands and selects analysis protocols
a. Quantitative analysis - Retina
1. Retinal Thickness
2. Retinal Map
3. Retinal Thickness / Volume
4. Retinal Thickness / Volume Tabular
5. Retinal Thickness / Volume Change
b. Quantitative analysis — Glaucoma
l. Retinal Thickness / Volume Tabular
2. Retinal Thickness / Volume Change
3. RNFL Thickness
4. RNFL Thickness Average
5. RNFL Thickness Map
6. RNFL Thickness Change
7. RNFL Thickness Serial Analysis
8. Optic Nerve Head
c. Image Processing Protocols — Retina
1. Normalize
2. Align
3. Normalize & Align
4. Proportional
5. Scan Profile
d. Image Processing Protocols — Glaucoma
1. Normalize
2. Align
3. Normalize & Align
4. Scan Profile
5. Understands the function and properties of the following:
a. Controls
l. Chin/Forehead rest
2. Table height
3. Internal fixation device
4. External fixation device
5. Focus knob
6. Video brightness
7. Video contrast
8. OCT Image noise
9. OCT Image range
10. Line length
11. Line angle
b. 7 offset
l. Auto
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c.

2. Manual
Position/move patient module
Polarization

1. Auto

2. Manual

Resolution

B. Data and Image Management

1.

2.
3.
4

5

Storage utilization

Organizes archival system

Coordinates network file transfers for archiving/patient data base systems
Exports Images and data:

a. to CD /DVD-Ram

b. to external USB device

c. floppy
Networks the OCT

V. Interpretation of OCT

A. Retina

PN R LD

Nel

10.
11.
12.

False color scale

Center point

Center thickness measurement
Total macular volume

Retinal map

Measurement calipers
Shadowing

Analysis artifacts/plotting errors/failures
Signal strength

+/- Center deviation
Signal-to-noise ratio

Accepted A-Scan%

B. Optic Nerve

PN R LD

Nel

10.
11.

False color scale

Disc reference points
Surface sensitivity
Disc area

Cup area

Rim area

Cup/disc area ratio
Cup/disc horizontal ratio
Cup/disc vertical ratio
Analysis artifacts
Save current result

C. Troubleshooting

S e

~J

Vibration

Printer maintenance
Patient tear film
Clean lens

IOL

Dilation

Media opacities

VI Patient/Operator Safety
A. Adheres to Universal Precautions as defined by the Centers for Disease Control and Prevention (CDC)
B. Observes Occupational Safety and Health Administration (OSHA) and

The National Institute for Occupational Safety and Health (NIOSH) regulations relating to OCT

C. Understands HIPAA confidentially and privacy regulations relating to OCT
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WRITTEN EXAMINATION

The OCT-C written examination consists of a total of 100 questions. Two hours are allotted for completion of the exam. The test
includes 100 multiple choice questions. Each multiple-choice question has four answer choices listed; only one is correct. Questions
with corresponding images will be clearly identified both in the Test booklet and the corresponding Image Book. The numbered
questions are answered by selecting the correct answer from multiple choices. The images contain specific information that is clearly
indicated.

There is only ONE correct response to each question. Read carefully and choose the single best response. A single question with
multiple answers will be scored incorrect. Use your time economically. Answer those questions you are sure of first. Then, if time
allows, go back and try to determine the correct answer for the more difficult questions. Try to answer all questions, including those
for which you are unsure of the answer.

The written examination is scored on the basis of the total number of correct responses. Omitted responses are scored as incorrect.
After the test administration and prior to the final scoring of the examinations, all test items are statistically validated. Passing or
failing the examination depends on the number of correct responses, and is not related to the scores of other applicants taking the
examination.

REQUIREMENTS FOR RECERTIFICATION

Certificants are required to recertify at three-year intervals following initial certification. Recertification may be gained by retesting

or accrual of continuing edcation credit. It is the responsibility of the Optical Coherence Tomographer-Certified to provide proof of
compliance with the recertification requirements prior to the end of the third year of each interval of certification. Failure to do so will
result in the revocation of OPS certification. Once revoked, certification can only be regained by applying for and fulfilling the current
requirements for OCT-C certification.

The requirements for recertification are as follows:

1. Recertification requires retesting prior to the end of the third year of each interval of certificaion.
OR.
2, Recertification requires the accrual of 8 hours of continuing education credit (8 CECs) during each three-year interval

following initial certification.
CECs may be earned in the following manner:

A. Of the eight required hours, @ minimum of 4 (4 CECs) MUST be earned by attending official OPS courses
or OPS BOC pre-approved courses and workshops. Each hour of lecture or workshop equals one credit hour (1
CECQ).

B. Of the eight required hours, a maximum of 6 (6 CECs) MAY be earned by teaching official OPS or OPS
approved courses or workshops. Each hour of lecture or workshop equals one credit hour (1 CEC).

C. Of the eight required hours, a maximum of 4 (4 CECs) MAY be earned by attending NON-OPS
APPROVED courses or workshops. These include courses or workshops approved by the Joint Commission
of Allied Health Personnel in Ophthalmology (JCAHPO) or courses approved by the American Medical
Association (AMA) for Category I Continuing Ophthalmic Medical Education. Each hour of these courses or
workshops equals one half-credit hour (1/2 CEC).

D. Of the eight required hours, a maximum of 3 (2 CECs) MAY be earned by first authorship or co-authorship
in the OPS Journal, ophthalmic or photographic journals or text books and other scientific publications. All
submissions must be of merit and well recognized. The total value for any submission shall not exceed three
(3 CECs). Submission of publications for CEC review must be made by separate application. (See CECs for
Publication on OPS website for details)
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Responsibility and Verifications

It is the responsibility of certificants to keep track of their CECs and submit their application with supporting
documentation verifying course teaching, course or workshop attendance or publication credits. Credits for teaching
must be supported by a copy of the printed program reflecting the type and degree of involvement. A certificate

of attendance or statement of attendance on official letterhead from the director of the course or workshop is
required. A paid receipt is not acceptable as evidence of attendance. Credits for publications must be supported by
a validation letter from the Recertification Section Chair. CECs submitted for CRA recertificantion may also be
submitted for OCT-C recertification.

3. Payment of the prevailing recertification fee, payable in US dollars to the OPS/BOC. Certificants that choose to retest will
pay the prevailing examination fee and will not be required to pay a recertification fee.

Recertification Fees

Non-member Fee: $160.00

OPS Member Fee: $ 80.00

Please call the OPS Membership Office (1-800-403-1677) to verify your membership status.
Fees should be payable to the OPS BOC in US dollars.

Recertification Extensions and Appeals

Recertification extensions may be issued on a individual basis due to extreme hardship. The Recertification Section Chair
(Recert@opsweb.org) is authorized to give a one time 6 week extension. Letters of revocation are sent after the 6 week
period. Should recertification be denied, the applicant may appeal within thirty (30) days to the Chair of the Board of
Certification (BOC@opsweb.org). Appeal instructions are provided with the letter of revocation. The Board of Certification
decision regarding all appeals will be final and binding. (Refer to appeals and grievances policy on page 6 for details.)

Recertification Applications and Information

The Chair of the Recertification Section annually mails, in February, applications to certificants with an expiration date of
December 31 of that con-current year. Certificants that have not received their application by March 1* of their third year of
certification, should contact the Recertification Section Chair (Recert@opsweb.org).

Certificants having difficulty completing their requirements or expect to be unable to meet the December 31* deadline should
contact the Recertification Section Chair (Recert@opsweb.org) as soon as possible. The Recertification Section Chair may

be able to provide assistance or a course of action for completing the requirements.

Certificants should contact the Section Chair by mail, fax or phone for current answers to any questions or concerns about
recertification requirements or accrual of continuing education credits.
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DISCIPLINARY POLICY

The OPS BOC may impose sanctions against applicants or individuals already awarded certification for failure to meet OPS BOC
rules and standards of initial certification or recertification. The OCT-C program is a voluntary process, not required by law for
employment in the field. Monitoring and evaluating actual job performance is beyond the scope of the OPS BOC.

Grounds for Action. The Board of Certification reserves the right to deny certification, void examination results, bar participation in
the certification program or to revoke certification. The following are grounds for action:

e Obtaining or attempting to obtain certification or recertification for oneself or another through fraud or misrepresentation
on any certification application, document, portfolio, or examination.

e Improper conduct during the examination, including, but not limited to giving or receiving answers from another
applicant, attempting to remove test materials or information from any examination room, or impersonating another
applicant.

e Unauthorized possession, distribution or disclosure of examination materials or content.

e Misrepresentation of certification or certification status.

e Gross or repeated negligence in providing ophthalmic photography services.

e Substance abuse to a degree, which impairs professional performance.

e Physical or mental condition which impairs competent professional performance.

e Physical or sexual abuse of a patient.

e The conviction of, plea of guilty, or plea of nolo contendere to a crime which is directly related to public health, safety,
or professional performance providing ophthalmic photography services.

e Failure to cooperate reasonably with any OPS BOC investigation of a disciplinary matter.

Sanctions for violation of standards of conduct or examination procedures may include:

e Denial or suspension of eligibility

e Re-examination

e Revocation

e Censure

e Reprimand

e Suspension

e Probation

e Other corrective action as the OPS BOC deems appropriate

Sanctions may be appealed. All appeals must be submitted as directed in the sanction to the Chair of the Board of Certification.
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Application Submission Check List

1. Program Application completed. dated. and signed.
2. Portfolio Submission Form completed. dated, and signed.
3. Complete OCT-C Portfolio enclosed.

4, Application fee enclosed
($50.00 payable in US dollars to the OPS/BOC).

Mailing Address:

OCT-C Portfolio Committee

Beth Ann Benetz, CRA, FOPS

University Hospitals Case Medical Center
11100 Euclid Ave, Wearn 644

Cleveland, OH 44106-5068
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Ophthalmic Photographers’ Society Board of Certification

OCT-C PROGRAM APPLICATION

Name:
Last First MI
Home Address:
Home Phone: ( ) -
Business Phone: ( ) -
Business Fax: ( ) -
E-mail:

Please answer the following questions: (For statistical purposes only)

Level of education or training (check all that apply): ___High School ___Some College __ College Degree  ___Graduate Degree

___CRA __ROUB ___COoA ___cot __coMmT __RN __LPN
___Medical Degree Other

Describe your years of professional experience in the field of Ophthalmic Photography:

__Less than 2 years ___4-6years ___more than 10 years
__2-3years ___7-10 years
Are you a member of the Ophthalmic Photographers’ Society? __Yes ___No ___ Other professional groups?

How did you hear about the Ophthalmic Photographers’ Society Certification Program?

___ OPS Member ___ Colleagues ___ Employer __ OPS Website Educational Meeting

Please read and sign the following statement indicating your acceptance.

I hereby request admittance into the Certification Program of the Ophthalmic Photographers’ Society Board of Certification for the designation of
Optical Coherence Tomographer-Certified subject to the requirements for certification set forth in the OCT-C Program Guide.

| understand in order to apply to sit for the Optical Coherence Tomography-Certified examination, | must

verify an employment history as with OCT as part of my responsibilities for a minimum of one year.
(See Eligibility Requirements in the OCT-C Program Guide page 8)

I understand and accept that the Ophthalmic Photographers’ Society Board of Certification makes the designation of Optical Coherence Tomographer-Certified
alone. Its sole purpose is to recognize the attainment of a standard level of knowledge and ability in ophthalmic photography and the liability of the Board or its
representatives is limited strictly to this recognition. There is no guarantee of its recognition by any other individual, group, agency or institution.

I'understand and accept that the Board of Certification reserves the right to make changes in policy, procedures, fees, and examination without notification.

I understand and accept that all decisions of the Board of Certification consistent with the policies and grievances procedures of the Board of Certification are
final.

SIGNATURE DATE

A COMPLETED PORTFOLIO SUBMISSION FORM, PORTFOLIO AND A CHECK PAYABLE TO THE OPS/BOC IN THE AMOUNT OF $50.00
(NON-REFUNDABLE US DOLLARS) MUST ACCOMPANY THE COMPLETED PROGRAM APPLICATION.
PLEASE RETAIN A COPY OF THIS APPLICATION FOR YOUR RECORDS.
MAIL THE COMPLETED APPLICATION, PORTFOLIO, PORTFOLIO FORM AND CHECK TO THE PORTFOLIO CHAIR.
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Ophthalmic Photographers’ Society Board of Certification
PORTFOLIO SUBMISSION FORM

Complete this form and submit it with the portfolio. Your portfolio will be reviewed within thirty days
by the Portfolio Committee and returned to the address listed below.

Name

Address

City State Zip

Preferred Contact Phone Email

Alternate Phone (Home/Business/Cell) Fax

PLEASE READ THE FOLLOWING STATEMENTS AND SIGN TO INDICATE ACCEPTANCE.

I submit my OCT-C portfolio prepared in accordance with the requirements outlined in the OCT-C Program Guide, for
review by the OCT-C Portfolio Committee of the Ophthalmic Photographers’ Society Board of Certification.

This enclosed portfolio represents work I have personally completed. I understand and accept that the portfolio must
be produced entirely by myself and that fraudulent submissions for any of the eligibility requirements may result in
disqualification.

I understand and accept that the Ophthalmic Photographers’ Society Board of Certification assumes no liability for any
portfolio materials lost or damaged in shipping and handling.

By signing and submitting this form, I accept the terms set forth in the OCT-C Program Guide regarding the OCT-C
portfolio requirements.

Signature Date

Send this form with your completed portfolio, application and application fee to the address below for
review.

OCT-C Portfolio Committee

Beth Ann Benetz, CRA, FOPS

University Hospitals Case Medical Center
11100 Euclid Ave, Wearn 644

Cleveland, OH 44106-5068
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APPENDIX A

Suggested Stratagies for De-identification

Seneral Dota | Comment | Diagnoses | Categarie: | Cinical Notes | 62010
Allow Cl K
OCT & Ye
First Name: [Peter Hay © No
OPTION 1 - New Scans — :
aaaaaaaa 1/ 11900 = M
sendes Urikriown -

Create a patient record as follows:

LAST NAME - OCT Portfolio stz 5
FIRST NAME - Candidate’s name -
Date: 1/1/1900 Sror e

Gender - unknown i
Patient ID - Item # —

When scanning for the portfolio, all scans can be done under the patient named “OCT Portfo-
lio”. If you are scanning a patient, you can do the requested scans under the patient’s actual
record and then perform the portfolio scans after selecting the OCT Portfolio record. When
exporting to PDF/printing, make sure to label each file/print with the scan number as defined in
the labeling instructions.

OPTION 2 - Existing Scans/Screen Capture

Perform a screen capture of the analysis you intend to submit (instructions in Appendix B) and
edit the patient information in PAINT or an image editing software. Follow the naming conven-
tion outlined above and in the portfolio guidelines. When exporting to PDF/printing, make sure
to label each file/print with the scan number as defined in the labeling instructions.

OPTION 3 - Existing Scan - Edit Database

Edit the patient information following the naming convention outlined above and in the portfo-
lio guidelines, export to PDF/print, and then re-enter the patient information. When exporting
to PDF/printing, make sure to label each file/print with the scan number as defined in the label-
ing instructions. WARNING - when using this method, you are editing the patient database.
Please carefully follow the instructions in Appendix C.
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APPENDIX B

Screen Capture Guide

To capture and save screens, use the Microsoft Paint program and then the
Kodak Imaging program, which are installed on STRATUS OCT computers.
This method allows you to save images in JPG format, enabling you to save
several full-screen images on a floppy disk.

On the STRATUS OCT, display the desired screen or scan and press the
Print Screen key. The Windows Clipboard captures the currently visible
portion of the screen as a bitmap. If the screen is scrollable, you must
scroll to the desired portion before capture.

_ Note: The Clipboard holds only one image at a time. When you
capture another screen, the Clipboard writes over the last one.

Press Ctrl-Esc to access the Windows Start menu and select Programs
> Accessories > Paint. Paste the Clipboard contents by pressing Ctrl-V
or selecting Edit > Paste. If a popup window appears, click Yes to
enlarge the bitmap to fit the image.

Select File > Save Asto save the image with the desired name and file
location. Save the image as a 24-bit Bitmap file for best resolution. We
suggest saving the image in the My Pictures folder.

To convert saved screens to JPEG format, press Ctrl-Esc and select
Programs > Accessories > Imaging. In the Imaging program, click File
> Open, then find and open the desired screen in the (My Pictures)

folder where you saved it.

With the desired screen now open, click File > Save As. In the Save as
type field, select JPG File (*.jpg). We suggest you use the same name
as the original file. To transfer the image to removable media, insert the
appropriate media into its drive and save the image to either the floppy
drive (A:) or the DVD-RAM drive (D:).

To continue obtaining images or converting them to JPG’s, switch
between programs by pressing Alt-Tab. When finished, close the
imaging programs and you will return to the STR4TUS OCT software.

S TIRNAT U oo

Zeiss STRATUS ocr Quick Guide PN 54003 Rev. A 7002
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APPENDIX C

To Edit A Previous (Already Existing) Patient Record
(Please Read and Follow Directions Carefully.)

Locate Patient’s Name on Patient Record List

Click the EDIT Button

Before Changing Patient Information CAREFULLY NOTE the Information in all of the fields
Backspace out Patient’s Last Name, enter: OCT Certification
Backspace out Patient’s First Name, Candidate Name (Your Name)
Backspace out Date of Birth, enter: 1-1-1900

Under Gender, Select: Unknown

Under Ethnicity Select: Blank

Under Patient ID, enter Item # ( Example : Item 1A or 2A)

Review Edits

At bottom of Date Entry Screen, Select Apply

Print/Save scans as directed.

To Re-Apply Patient Information to patient record:
Repeat the Above Steps and re-enter the patient’s information.

Be sure to include ALL FIELDS as they were previously entered.
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